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RESUMEN.- Se desarrolló un nuevo método de evaluación del nivel de daño pro-
vocado a los tubérculos por las larvas de polillas de la papa. El método se basa en
el análisis de imágenes digitales, mediante la utilización de herramientas tecnoló-
gicas como son los paquetes libres: Gimp 2.6.4 y Scion Image. Se hizo una com-
paración entre la metodología propuesta y la metodología convencional basada en
una evaluación visual de los daños. Se encontró que el nuevo método es particular-
mente confiable para medir los niveles de daño intermedios que son difíciles de
estimar de manera visual. Finalmente, se determinó que con el uso de la metodolo-
gía propuesta se pueden obtener datos más objetivos y precisos debido a que no
están sujetos a interpretaciones humanas.

PALABRAS CLAVE: Gimp 2.6.4, índice de daño, polilla de la papa, Scion Image.

ABSTRACT.- This study presents a new method to evaluate the level of tuber
damage caused by potato moth larvae. This methodology was based on analyses of
digital images through the use of technological tools available on the market such
as the free softwares: Gimp 2.6.4 and Scion Image. A comparison was made
between the proposed methodology and the conventional one based on a visual
assessment of damage. It was found that the new method is particularly reliable for
measuring intermediate levels of damage that are difficult to estimate visually.
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Finally, we discuss how the use of this methodology could be more objective and
accurate to quantify by eliminating human interpretations.

KEY WORDS: Damage index, Gimp 2.6.4, potato moth, Scion Image. 

INTRODUCCIÓN
El complejo de las polillas de la

papa, Phthorimaea operculella (Zeller),
Tecia solanivora (Polvony) y Symme-
trischema tangolias (Gyen, 1913)
(Lepidoptera: Gelechiidae), es uno de
los grupos de plagas que causa mayor
daño a este cultivo, tanto en campo
como en almacenamiento (1). T. solani-
vora fue introducida a Ecuador en
1996, a través de una importación de
semilla no certificada proveniente de
Colombia, con destino a las zonas
paperas del Carchi (2). La larva se ali-
menta inicialmente encima de la piel
del tubérculo, para luego barrenar más
profundamente y formar galerías sinuo-
sas (3).

La estimación visual del daño cau-
sado por las plagas ha sido uno de los
métodos utilizados históricamente por
los investigadores y extensionistas para
evaluar la eficiencia de los diferentes
controles usados para el manejo de
estos insectos (4, 5). En este tipo de
evaluación se realiza una estimación
visual del porcentaje de daño del tubér-
culo y se aplica un sistema de puntaje
basado en los valores propuestos por
Arias et al. (6) o Murcia y Barreto (7),
con valores que van de 0 (0% de daño)

a 4 (entre 76% a 100% de daño); el pro-
blema con este tipo de evaluación es
que puede ser subjetivo y tiene limita-
ciones en cuanto a precisión (8). 

Los avances en el procesamiento de
imágenes digitales, en las metodologías
usadas para los análisis y en cuanto a la
tecnología de las computadoras, han
exhibido un crecimiento impresionante
en las pasadas décadas (9). Todo esto se
constituye en tecnologías que lideran
importantes áreas; por ejemplo, teleco-
municaciones digitales, radiodifusión,
imágenes médicas, biología, ciencias
de los materiales, sistemas multimedia
y sensores remotos; esto se refleja en la
existencia de un gran número de publi-
caciones en revistas científicas interna-
cionales, así como en libros especiali-
zados (9). 

El software de dominio público
SCION IMAGE es utilizado para reali-
zar análisis de imágenes digitales y ha
sido aplicado dentro de una amplia
gama de novedosos métodos de investi-
gación en agricultura aplicada, como
para medir el área de las hojas, la defo-
liación y el impacto de insectos fitófa-
gos sobre las hojas (10, 11); el porcen-
taje de cobertura de plagas invasivas
(12); la senescencia de las hojas (13,
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14), el estado del nutriente foliar (15).
Sin embargo, SCION IMAGE no había
sido utilizado para estudios relaciona-
dos con tubérculos y más específica-
mente para análisis de daños provoca-
dos por polillas de la papa.

Los entomólogos agrícolas siempre
han tenido el reto de estimar con preci-
sión el daño causado por las plagas en
los cultivos (10, 16). Aunque la papa
(Solanum tuberosum) es uno de los
principales cultivos de la región andina,
sorprendentemente, no existía una
metodología que permita evaluar de
una manera cuantitativa y objetiva el
daño provocado por las plagas en los
tubérculos. Este trabajo tiene como
objetivo específico el validar una meto-
dología que se basa en el análisis de
imágenes digitales para la determina-
ción precisa del nivel de daño produci-
do por T. solanivora, 

MATERIALES Y MÉTODOS

Establecimiento del ensayo
Se utilizaron 30 cajas de cartón

corrugado de 20 cm de ancho, 20 cm de
largo y 25 cm de altura. Cada caja
representó una unidad experimental
donde se depositaron diez tubérculos de
la variedad de papa Leona Blanca, los
cuales fueron infestados con 60 huevos
de T. solanivora. El ensayo se ubicó en
una bodega del cantón Salcedo, provin-
cia de Cotopaxi (Ecuador), a una altitud
de 2.729 msnm. La temperatura media

al interior de la bodega se registró usan-
do un termómetro máximo-mínimo
(Ertco, Dubuque, IA), fue de 14,5 ºC
(min = 9,5 ºC; máx = 20 ºC). Después
de 50 días se retiró el ensayo de la
bodega y los tubérculos fueron llevados
a los laboratorios de la Pontificia Uni-
versidad Católica del Ecuador en Quito
para ser evaluados.

Estimación visual del índice
de daño provocado por
T. solanivora en tubérculos
de papa
En total se evaluaron 300 tubércu-

los. Cada tubérculo fue cortado longitu-
dinalmente en cuatro partes; en cada
parte se estimó visualmente la intensi-
dad del daño evaluando el área afectada
por las larvas (Figura 1A). La sumato-
ria de daño de cada parte representa la
intensidad total del daño por papa que
varía entre 0 (ningún daño) y 100 (papa
totalmente dañada). Luego, este por-
centaje fue transformado a un índice
que va de 0 a 1 (6). 

Adquisición de la imagen digital
de los tubérculos
Se tomaron fotografías de las cua-

tro partes en las que fue cortada cada
una de las papas con una cámara digi-
tal Canon Power Shot S40 (Canon,
Tokyo, Japón). Se usó un soporte para
ubicar la cámara a una altura de 21
cm y un negatoscopio a manera de
caja de luz para evitar las sombras.
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Como fondo, se utilizaron hojas cua-
driculadas A4 (0,5 cm), para tener
una medida conocida de referencia.
Las fotos fueron exportadas a un
computador. Con ayuda del programa
de libre acceso GIMP 2.6.4 (Spencer
Kimball, Peter Mattis and the GIMP
Development Team), se estandarizó el
brillo de las fotos, se definió algunos
márgenes en los bordes de los tubér-
culos y se cambió de formato de jpg a
tif para que las fotos puedan ser ana-
lizadas con el programa de libre acce-
so Scion Image 4.0.2. Las fotos fue-
ron editadas para generar dos tipos
diferentes de imágenes; una para cal-
cular el área dañada de los tubérculos
(Figura 1B-1) y otra en la que se
invirtieron los colores para poder cal-
cular el área total de la papa (Figura
1B-2).

Procesamiento de las imágenes
con Scion Image
Para determinar el índice de daño

provocado por las larvas de T. solanivo-
ra se utilizó el software de dominio
público Scion Image 4.0.2 para Win-
dows (National Institute of Health,
Bethesda, MD, 

www.scioncorp.com/pages/scion
image_windows.htm). 

El programa permite analizar las
imágenes en color (Figura 1B-1) o en
escala de grises (Figura 1B-2). Se utili-
zó la versión a color para establecer la

escala real. Se utilizó la hoja cuadricu-
lada A4 para establecer cuantos pixeles
correspondían a un centímetro. Luego
se escogió del menú: Analize > Set
scale y se ingresó la equivalencia de 1
centímetro en pixeles. Luego, se cerró
la imagen a color y se continuó traba-
jando con la imagen en gradación de
grises (Figura 1B-2).
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Figura 1 (A).- Foto de tubérculo cortado en cua-
tro partes usado para el análisis del daño provocado
por larvas de T. salanivora. (B) Secuencia seguida
durante el manejo del programa SCION IMAGE: (1)
foto del tubérculo a color, (2) foto de la papa en esca-
la de grises, (3) visualización del área del tubérculo
dañada mediante la aplicación de la función Thres-
hold, (4) nivel donde se ubicó la función Threshold
para realizar el análisis, (50 área del tubérculo daña-
da, calculada (6) cuadro de los resultados correspon-
dientes al área de daño calculada, (7) área total de
papa calculada, (8) cuadro de los resultados corres-
pondientes al área calculada.
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Posteriormente se escogió del
menú: Analize > Options > Area > OK.
Luego se seleccionó del menú: Options
> Threshold y se comenzó a bajar el
contraste hasta que el umbral llegue a
155, una medida previamente estableci-
da para todas las imágenes (Figura 1B-
3, 1B-4). Con este valor se consigue el
óptimo de contraste entre las zonas
dañadas y las zonas sanas de la papa (en
negro en la Figura 1B-3). Seguidamen-
te, se escogió del menú: Analyze >
Analyze particles y el programa proce-
de a señalar las área que se va a calcu-
lar (Figura 1B-5). Finalmente, se esco-
gió del menú: Analyze > Show results
donde apareció en un recuadro los
resultados de las áreas calculadas

(Figura 1B-6). Esta información fue
copiada y exportada a una plantilla
hecha con el programa Excel (Micro-
soft, USA). Este procedimiento se
siguió para calcular el área de daño pro-
ducido por las larvas (Figura 1B-5, 1B-
6) y un procedimiento similar se aplicó
para calcular el área total de cada tubér-
culo (Figura 1B-7, 1B-8). Para determi-
nar el índice de daño de cada tubérculo,
se dividió el área dañada para el total
fotografiado. El tiempo total para pro-
cesar cada foto fue de aproximadamen-
te cuatro minutos.

Análisis estadístico
Para evaluar los métodos (visual vs.

análisis de imágenes digitales) de esti-
mación del daño se hizo un análisis de
regresión usando Minitab (Versión 1.5).
Se asumió que los datos obtenidos a tra-
vés de la evaluación de las imágenes
digitales corresponderían a los valores
observados y los datos obtenidos a tra-
vés de la evaluación visual correspon-
derían a los valores esperados. Siguien-
do las recomendaciones de Piñeiro et
al. (17), se ubicaron los valores espera-
dos en el eje de las X y los valores
observados en el eje de las Y. Se calcu-
ló la pendiente y la intersección.

Se calculó el coeficiente parcial de
desigualdad de Theil (Usesgo, Upendiente,

Uerror), el cual separa el error real de la
predicción (la suma de cuadrados del
error predicho), en diferentes compo-
nentes y complementa la evaluación
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Figura 2.- Relación entre el área evaluada con el
método SCION IMAGE y el área evaluada con el
método visual. La línea punteada representa una
línea de relación 1:1 que ayuda a visualizar mejor
relación entre los dos métodos evaluados. La línea
continua representa la linea de la regresión (Y =
0,758 * X + 0.029; P< 0,001)
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hecha con la regresión (18, 19). El coefi-
ciente de Theil divide la varianza de los
valores observados no explicados por los
valores predichos (llamado la suma de
cuadrados del error predicho), siendo
Usesgo, la proporción asociada con la
diferencia de las medias entre los valores
observados y los valores predichos,
Upendiente, la proporción asociada con la
pendiente del modelo ajustado y la línea
1:1 y Uerror, es la proporción asociada
con la varianza inexplicada (18).

Para observar la tendencia en la dis-
tribución del error se graficaron los
valores promedio de los pares de los
valores esperados y los valores obser-
vados en el eje de las abscisas y las
diferencias en el eje de las ordenadas
con el software Grapher (Versión 4.00).
Para hacer un análisis del error se hizo
una correlación de los datos obtenidos
por el Scion Image y la raíz cuadrada

del error medio o RMSE (la diferencia
entre los datos obtenidos por el método
visual y el Scion Image).

RESULTADOS 
Los valores de la estimación visual

y de la estimación por análisis de imá-
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Figura 3.- Distribución del error. Los puntos
representan las diferencias entre lo evaluado con el
análisis visual y el análisis de imágenes digitales.

Figura 4.- Análisis de la relación del área eva-
luada con SCION IMAGE y el RMSE (raíz cuadra-
da del error medio). (B) Frecuencia de la distribución
del error RMSE que cuantifica la diefrencia entre
ambos métodos.
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genes digitales muestran una buena
correspondencia (Figura 2, n= 300, r2=
0,79; P <0,001). La intercepción y la
pendiente fueron significativamente
diferentes de 1 y 0 (p < 0,001). La falta
de ajuste fue principalmente relaciona-
da al sesgo o a la diferencia media entre
lo observado y lo esperado (Usesgo=
0,48; Upendiente= 0,13; Uerror= 0,35).

La distribución del error sugiere que
hay una subestimación cuando aplicamos
la evaluación visual para determinar el
porcentaje de daño (Figura 3). Este error
es mayor en los valores intermedios. La
desviación estándar de la estimación
visual del porcentaje de daño fue de 0,22
y de la evaluación a través del análisis de
imágenes digitales fue de 0,19. 

El análisis del error producido al
usar el método de la evaluación visual
(RMSE) confirmó que la diferencia
más grande entre los dos métodos de
medida se presentó cuando se evalua-
ron niveles de daño intermedio, que
están entre 0,3–0,7 (Figura 4A) y no en
los casos extremos (0–0,3 ó 0,7–1).
Con respecto a la distribución del error
(Figura 4B), se observó que el grueso
de las diferencias entre los dos métodos
fue concentrado al inicio del cuadro de
barras (0 – 0,2). En el 53% de las mues-
tras evaluadas, se presentó una diferen-
cia en el índice obtenido de 0,1; mien-
tras que en el 84% de las muestras eva-
luadas existió una diferencia en el índi-
ce obtenido de 0,2. Los datos se ajusta-
ron a una curva normal (n = 300; =
0,1164; SD = 0,091). 

DISCUSIÓN
Una buena correspondencia de la

estimación visual del porcentaje de
daño con la evaluación de imágenes
digitales ya ha sido reportada en traba-
jos anteriores en estudios realizados
con enfermedades de plantas (6), en la
evaluación de daño causado por plagas
(20, 21) y en la evaluación de lesiones
gástricas (22). En cuanto a la distribu-
ción del error, éste es mayor en los
valores intermedios, lo que se explica
a través de la ley de Weber-Fechner,
que propone que el ojo humano estima
daños altos o bajos con mayor preci-
sión que rangos medios de severidad
(23). 

En la práctica, la existencia de una
distribución normal es de especial
importancia. De hecho, se da mayor
peso a los resultados correspondientes
a estos niveles intermedios, que son
difíciles de medir o donde existe
mayor probabilidad de cometer errores
de apreciación. Esta situación puede
ser importante al momento de tomar
una decisión para recomendar un con-
trol enfocado en mejorar el manejo de
la plaga.

Los resultados obtenidos apuntan a
que con el procesamiento de imágenes
digitales se pueden obtener datos más
precisos y se eliminan errores origina-
dos por subjetividad. Esto concuerda
con resultados obtenidos por otros
investigadores (10, 20, 24, 25). 
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CONCLUSIONES
El análisis de imágenes digitales

se ha utilizado con éxito desde hace
algún tiempo atrás en investigaciones
relacionadas con agricultura aplicada.
Esta es la primera vez que se propone
un método cuantitativo, con un proce-
dimiento de evaluación más objetivo y
preciso para evaluar niveles de daño
provocados por las polillas de la papa
y en particular T. solanivora. Se
podría también usar en el caso de
otros insectos plaga de la papa o de
otros tubérculos. Esta metodología
deja de lado la percepción humana y
da paso al uso de herramientas tecno-
lógicas que están a nuestro alcance y
nos permiten tener mayor precisión.
La evaluación de los daños mediante
el método presentado en este trabajo
requiere de un poco más de tiempo y
esfuerzo que la evaluación visual
pero, en contraparte, sin gastos exce-
sivos (por el uso de acceso libre), se
obtienen datos más depurados y con-
fiables. Además, hay que mencionar
que el SCION IMAGE tiene otras
opciones, como la de poder medir
cada una de las partículas dañadas.
Esto permitiría cuantificar, por sepa-
rado, el daño producido por varias
plagas en un mismo tubérculo. Esta
posibilidad parece muy interesante, en
particular en la zona andina, conside-
rando que diferentes especies de poli-
llas de la papa se encuentran en sim-
patría.
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